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1  Welcome to the AM/FM/RDS option
The R&S SMCVB-K155 is a firmware application that adds functionality to generate
signals in accordance with the AM/FM/RDS digital standards.

The R&S SMCVB-K155 option features:

● Audio AM broadcast signal generation
● Audio FM broadcast signal generation
● Audio FM RDS/RBDS signal generation

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMCV100B user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMCV100B

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMCV100B service manual.

1.1  Accessing the AM/FM/RDS dialog

To open the dialog with AM/FM/RDS settings

► In the block diagram of the R&S SMCV100B, select "Baseband > AM/FM/RDS".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.2  What's new

This manual describes firmware version FW 5.20.043.xx and later of the
R&S®SMCV100B.

Compared to the previous version, there are editorial changes only.

1.3  Documentation overview

This section provides an overview of the R&S SMCV100B user documentation. Unless
specified otherwise, you find the documents at:

Documentation overview

https://www.rohde-schwarz.com/manual/smcv100b
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www.rohde-schwarz.com/manual/smcv100b

1.3.1  Getting started manual

Introduces the R&S SMCV100B and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.3.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMCV100B is not included.

The contents of the user manuals are available as help in the R&S SMCV100B. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.3.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.3.4  Instrument security procedures

Deals with security issues when working with the R&S SMCV100B in secure areas. It
is available for download on the internet.

Documentation overview

http://www.rohde-schwarz.com/manual/smcv100b
https://gloris.rohde-schwarz.com
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1.3.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.3.6  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMCV100B. It also
lists the options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smcv100b

1.3.7  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smcv100b

1.3.8  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smcv100b

1.3.9  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

Documentation overview

http://www.rohde-schwarz.com/brochure-datasheet/smcv100b
http://www.rohde-schwarz.com/firmware/smcv100b
http://www.rohde-schwarz.com/application/smcv100b
https://www.youtube.com/@RohdeundSchwarz
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1.4  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMCV100B user manual.

1.5  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  About the AM/FM/RDS option
Use the AM/FM/RDS coder option to generate broadcast signals in FM and AM.

In FM, you can generate a mono or a stereo signal. For stereo signals generated
according to the multiplex method, an RDS coder is available and is used to code fixed
data. Many parameters can be changed over wide setting ranges. See Chapter 4,
"Audio FM configuration and settings", on page 18.

In AM, you can generate amplitude modulated signals. See Chapter 3, "Audio AM con-
figuration and settings", on page 12.

To generate an audio FM broadcast signal

1. Select "Baseband > Audio FM > State > On".

2. Select "RF > RF Level > State > On".

To generate an audio AM broadcast signal

1. Select "Baseband > Audio AM > State > On".

2. Select "RF > RF Level > State > On".

2.1  Required options

The equipment layout for generating AM/FM/RDS signals includes:
● Base unit
● Option Enable Broadcast Standard (R&S SMCVB-K519)
● Option AM/FM/RDS (R&S SMCVB-K155)

Required options
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3  Audio AM configuration and settings
Access:

► Select "Baseband > Audio AM".

This section provides an overview on the AM settings.

The remote commands required to define these settings are described in Chapter 6.1,
"Audio AM commands", on page 58.

How to: "To generate an audio AM broadcast signal" on page 11

Settings:

● General settings......................................................................................................12
● AM modulator settings............................................................................................ 13

3.1  General settings

Access:

► Select "Baseband > Audio AM > Audio AM".

The tab provides functionality for calling default settings, save and recall settings.

Settings:

State..............................................................................................................................12
Set To Default................................................................................................................12
Save/Recall................................................................................................................... 13

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:STATe on page 58

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

General settings
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Parameter Value

State Not affected by the "Set to Default"

Remote command: 
[:SOURce<hw>]:BB:RADio:AM:PRESet on page 58

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMCV100B user manual.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:SETTing:CATalog on page 58
[:SOURce<hw>]:BB:RADio:AM:SETTing:DELete on page 59
[:SOURce<hw>]:BB:RADio:AM:SETTing:LOAD on page 59
[:SOURce<hw>]:BB:RADio:AM:SETTing:STORe on page 59

3.2  AM modulator settings

Access:

► Select "Baseband > Audio AM > AM Modulator".

The dialog provides settings necessary to configure the AM modulator.

Settings:

● Audio signal settings............................................................................................... 14
● Modulation settings................................................................................................. 17

AM modulator settings
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3.2.1  Audio signal settings

Access:

► Select "AM Modulator > Audio Signal".

The tab provides input and audio settings of the signal, that is fed into the AM mod-
ulator.

Settings:

Input Signal................................................................................................................... 14
Audio............................................................................................................................. 14
Frequency..................................................................................................................... 15
Level..............................................................................................................................15
Load File....................................................................................................................... 15

└ Predefined Files..............................................................................................15
Attenuation.................................................................................................................... 16
Source...........................................................................................................................16

Input Signal
Sets the audio source for the AM modulator signal.
"External" Uses an external audio signal input at the "User 2" connector.

The audio source is fixed to "Source > S/PDIF".
"Audio Generator"

Uses an internal audio generator as the signal source.
You can enable the audio channel, set the audio level and set the
audio frequency.

"Audio Player" Uses a file, that is saved to the memory of the R&S SMCV100B.
You can load a file, set the audio channel and set the attenuation.
See "Load File" on page 15.

"Off" Disables the audio source for the AM modulator.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:INPut on page 61

Audio
Requires "Input Signal > Audio Generator/Audio Player".
Enables or disables the audio channel.

AM modulator settings
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Remote command: 
[:SOURce<hw>]:BB:RADio:AM:AUDio:AF on page 61

Frequency
Requires "Input Signal > Audio Generator".
Sets the frequency.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:AUDGen:FRQ on page 60

Level
Requires "Input Signal > Audio Generator/Audio Player".
Sets the level.
The nominal level, at which the modulation depth adjusts to the nominal modulation
depth, is 6 dBu. If the level is set to 6 dBu, the generated modulation depth corre-
sponds to the set value.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:AUDGen:LEV on page 60

Load File
Requires "Input Signal > Audio Player".
Provides access to the standard "File Select" function of the instrument. The provided
navigation possibilities in the dialog are self-explanatory.
See also, chapter "File and Data Management" in the R&S SMCV100B User Manual.
You can load files with extension *.wv and *.wav. If loaded, the name of the file is
displayed next to the button.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:CATalog on page 60
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:SELect on page 60

Predefined Files ← Load File
The tab list predefined files and displays information on the file. For an overview, see
the table below.
Table 3-1: File information

File information Remark

Date Format: <dd-mm-yyyy>

Time Format: <hh:mm:ss>

Size File size in Mbyte, Increment: 0.00001 Mbyte

Sample rate Supported sample rates: 44.1 kHz and 48 kHz

Number of samples -

Example: Loading a predefined file
Select "Load File > Predefined Files" and select the audio file
default_sine_1khz.wav in the list.

AM modulator settings
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Information on the file is displayed on the right panel. See also Table 3-1.

To load the file, click "Select". The file is displayed on the "Load File" button.

Attenuation
Requires "Input Signal > Audio Player".
Sets the attenuation.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:APLayer:ATT on page 59

Source
Requires "Input Signal > External".
Displays the audio source, that is fixed to S/PDIF.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:SOURce on page 62

AM modulator settings
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3.2.2  Modulation settings

Access:

► Select "AM Modulator > Modulation".

The tab provides AM modulation settings.

Settings:

Nom. Mod. Depth.......................................................................................................... 17
Mod. Depth....................................................................................................................17

Nom. Mod. Depth
Sets the nominal modulation depth.
The depth denotes the referenced depth and depends on the input signal, see "Input
Signal" on page 14.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:DEPTh on page 61

Mod. Depth
Displays the modulation depth.
Remote command: 
[:SOURce<hw>]:BB:RADio:AM:MODulation:DEPTh? on page 61

AM modulator settings
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4  Audio FM configuration and settings
Access:

► Select "Baseband > Audio FM".

This section provides an overview on the FM and RDS settings. The variety of settings
depends on whether the FM mode. For "Mode > Stereo", you can further specify left
and the right channel settings, see "Mode" on page 26.

The remote commands required to define these settings are described in Chapter 6,
"Remote-control commands", on page 57.

How to: "To generate an audio FM broadcast signal" on page 11

Settings:

● General settings......................................................................................................18
● FM modulator settings.............................................................................................19
● RDS/RBDS settings................................................................................................ 27
● AF settings.............................................................................................................. 34
● EON settings...........................................................................................................39
● TMC / open format settings.....................................................................................46
● DARC settings.........................................................................................................53
● Special settings.......................................................................................................54

4.1  General settings

Access:

► Select "Baseband > Audio FM > Audio FM".

The tab provides functionality for calling default settings, save and recall settings.

Settings:

State..............................................................................................................................18
Set To Default................................................................................................................19
Save/Recall................................................................................................................... 19

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

General settings
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Remote command: 
[:SOURce<hw>]:BB:RADio:FM:STATe on page 63

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

State Not affected by the "Set to Default"

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:PRESet on page 62

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMCV100B user manual.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:SETTing:CATalog on page 63
[:SOURce<hw>]:BB:RADio:FM:SETTing:DELete on page 63
[:SOURce<hw>]:BB:RADio:FM:SETTing:LOAD on page 63
[:SOURce<hw>]:BB:RADio:FM:SETTing:STORe on page 63

4.2  FM modulator settings

Access:

► Select "Baseband > Audio FM > FM Modulator".

The dialog provides access to settings necessary to configure the input signal and
the FM modulator.

Settings:

● Audio signal settings............................................................................................... 20
● Modulation settings................................................................................................. 25

FM modulator settings
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4.2.1  Audio signal settings

Access:

► Select "FM Modulator > Audio Signal".

The tab provides input and audio settings of the signal, that is fed into the FM mod-
ulator.

Settings:

Input Signal................................................................................................................... 20
AF Mode........................................................................................................................21
Audio Left...................................................................................................................... 21

└ Audio...............................................................................................................21
└ Level............................................................................................................... 22
└ Frequency.......................................................................................................22
└ Attenuation......................................................................................................22

Audio Right....................................................................................................................22
└ Audio...............................................................................................................23
└ Level............................................................................................................... 23
└ Frequency.......................................................................................................23
└ Attenuation......................................................................................................23

Load File....................................................................................................................... 24
└ Predefined Files..............................................................................................24

Source...........................................................................................................................25

Input Signal
Sets the audio source for the FM modulator signal.
"External" Uses an external audio signal input at the "User 2" connector.

The audio source is fixed to "Source > S/PDIF".

FM modulator settings
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"Audio Generator"
Uses an internal audio generator as the signal source.
You can enable the audio channel, set the audio level and set the
audio frequency for mono and stereo modulation mode.

"Audio Player" Uses a file, that is saved to the memory of the R&S SMCV100B.
You can load a file, set the audio channel and set the attenuation.
See "Load File" on page 24.

"Off" Disables the audio source for the FM modulator.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:INPut on page 67

AF Mode
Requires "Input Signal > Audio Generator" and "Modulation > Mode > Stereo".
Sets the relationship of the two audio channels with respect to each other.
"L" Only the audio signal from the left audio channel is processed further.

The right audio channel is ignored.
"R" Only the audio signal from the right audio channel is processed fur-

ther. The left audio channel is ignored.
"L = R" The audio signal for the left and right channel is identical. Only the

audio signal of the left channel is used, the audio signal of the right
channel is ignored. Therefore, only the settings for the left channel
are available.
As a result, the stereo signal (L-R)/2 disappears as upper and lower
sideband around the suppressed 38 kHz carrier.

"L = -R" The phase of the audio signal for the left and right channel is offset by
180 degrees. Only the audio signal of the left channel is used, the
audio signal of the right channel is ignored. Therefore, only the set-
tings for the left channel are available.
As a result, the mono signal (L+R)/2 disappears in the frequency
range up to 15 kHz.

"L ≠ R" The audio signals from the left and right audio channel are processed
according to the coding standard for a stereo multiplex signal.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:MODE on page 66

Audio Left
Displaying the panel requires "Modulation > Mode > Stereo".
The panel groups level and frequency parameters of the left audio channel. The
description of the parameters also applies for "Mode > Mono", since the left audio
channel is the mono audio channel.

Audio ← Audio Left
Enables or disables the audio channel.
You can enable 1 or 2 audio channels depending on the modulation mode:
● If "Modulation > Mode > Stereo", enable left or right audio channel separately.

FM modulator settings
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● If "Modulation > Mode > Mono", enable the audio channel, that is the left audio
channel.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF2 on page 65

Level ← Audio Left
Requires "Input Signal > Audio Generator".
Sets the level.
The nominal level, at which the modulation depth adjusts to the nominal modulation
depth, is 6 dBu. If the level is set to 6 dBu, the generated modulation depth corre-
sponds to the set value.
You can set levels for one or two audio channels depending on the modulation mode:
● If "Modulation > Mode > Stereo", set left or right audio levels separately.
● If "Modulation > Mode > Mono", set the level related to the left audio channel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV2 on page 65

Frequency ← Audio Left
Requires "Input Signal > Audio Generator".
Sets the frequency.
You can set frequencies for one or two audio channels depending on the modulation
mode:
● If "Modulation > Mode > Stereo", set left or right audio frequencies separately.
● If "Modulation > Mode > Mono", set the frequency related to the left audio channel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ2 on page 65

Attenuation ← Audio Left
Requires "Input Signal > Audio Player".
Sets the attenuation.
You can set the attenuation for one or two audio channels depending on the modula-
tion mode:
● If "Modulation > Mode > Stereo", set left or right attenuations separately.
● If "Modulation > Mode > Mono", set the attenuation related to the left audio chan-

nel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT1 on page 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT2 on page 64

Audio Right
Displaying the panel requires "Modulation > Mode > Stereo".
The panel groups level and frequency parameters of the right audio channel.

FM modulator settings
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Audio ← Audio Right
Enables or disables the audio channel.
You can enable 1 or 2 audio channels depending on the modulation mode:
● If "Modulation > Mode > Stereo", enable left or right audio channel separately.
● If "Modulation > Mode > Mono", enable the audio channel, that is the left audio

channel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF2 on page 65

Level ← Audio Right
Requires "Input Signal > Audio Generator".
Sets the level.
The nominal level, at which the modulation depth adjusts to the nominal modulation
depth, is 6 dBu. If the level is set to 6 dBu, the generated modulation depth corre-
sponds to the set value.
You can set levels for one or two audio channels depending on the modulation mode:
● If "Modulation > Mode > Stereo", set left or right audio levels separately.
● If "Modulation > Mode > Mono", set the level related to the left audio channel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV2 on page 65

Frequency ← Audio Right
Requires "Input Signal > Audio Generator".
Sets the frequency.
You can set frequencies for one or two audio channels depending on the modulation
mode:
● If "Modulation > Mode > Stereo", set left or right audio frequencies separately.
● If "Modulation > Mode > Mono", set the frequency related to the left audio channel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ1 on page 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ2 on page 65

Attenuation ← Audio Right
Requires "Input Signal > Audio Player".
Sets the attenuation.
You can set the attenuation for one or two audio channels depending on the modula-
tion mode:
● If "Modulation > Mode > Stereo", set left or right attenuations separately.
● If "Modulation > Mode > Mono", set the attenuation related to the left audio chan-

nel.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT1 on page 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT2 on page 64
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Load File
Requires "Input Signal > Audio Player".
Provides access to the standard "File Select" function of the instrument. The provided
navigation possibilities in the dialog are self-explanatory.
See also, chapter "File and Data Management" in the R&S SMCV100B User Manual.
You can load files with extension *.wv and *.wav. If loaded, the name of the file is
displayed next to the button.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:CATalog on page 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:SELect on page 65

Predefined Files ← Load File
The tab list predefined files and displays information on the file. For an overview, see
the table below.
Table 4-1: File information

File information Remark

Date Format: <dd-mm-yyyy>

Time Format: <hh:mm:ss>

Size File size in Mbyte, Increment: 0.00001 Mbyte

Sample rate Supported sample rates: 44.1 kHz and 48 kHz

Number of samples -

Example: Loading a predefined file
Select "Load File > Predefined Files" and select the audio file
default_sine_1khz.wav in the list.

Information on the file is displayed on the right panel. See also Table 3-1.

To load the file, click "Select". The file is displayed on the "Load File" button.

FM modulator settings
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Source
Requires "Input Signal > External".
Displays the audio source, that is fixed to S/PDIF.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:SOURce? on page 66

4.2.2  Modulation settings

Access:

► Select "FM Modulator > Modulation".

The tab provides FM modulation settings.

Settings:

Mode............................................................................................................................. 26
Preemphasis................................................................................................................. 26
Nom. Freq. Dev. Audio..................................................................................................26
Freq. Dev. Audio............................................................................................................26
Freq. Dev. Pilot..............................................................................................................26
RDS/RBDS....................................................................................................................27
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Freq. Dev. RDS............................................................................................................. 27
DARC............................................................................................................................ 27
Freq. Dev. DARC...........................................................................................................27

Mode
Sets the FM mode.
"Stereo" Feeds a stereo signal to the modulator according to the multiplex

method with:
● Pilot tone: 19 kHz tone. You can disable the pilot tone and set the

pilot deviation. See "Pilot" on page 54 and "Freq. Dev. Pilot"
on page 26.

● RDS: 57 kHz, see "RDS/RBDS" on page 27.

"Mono" Feeds a mono signal to the modulator with band limitation 15 kHz.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:MODE on page 67

Preemphasis
Sets the preemphasis factor for the signal to noise ratio improvement.
To improve the SNR, the technique boosts high-frequency components at the modula-
tor and reduces them at the demodulator.

Example: 
The level increase at an input frequency of 15 kHz and a pre-emphasis of 50 μs is
13.66 dB. At a pre-emphasis of 75 μs, the SNR is 17.07 dB.
The audio input level for audio generator and audio player therefore needs to be
reduced in line with the pre-emphasis.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:PREemphasis on page 66

Nom. Freq. Dev. Audio
Defines the signal deviation, that is the deviation only caused by the audio signals.
The nominal deviation is 6 dBu.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:NDEViation on page 66

Freq. Dev. Audio
Displays the actual frequency deviation.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:AUDio:DEViation? on page 65

Freq. Dev. Pilot
Defines the resulting 19 kHz frequency deviation of the pilot tone irrespective of the
audio signals.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:PILot:DEViation on page 68
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RDS/RBDS
Requires "Mode > Stereo".
Enables/disables RDS/RBDS.
If enabled, adds a 57 kHz RDS signal to the multiplex signal in accordance with the
specification EN 62106.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS[:STATe] on page 70

Freq. Dev. RDS
Requires "Mode > Stereo" and "RDS/RBDS > On".
Defines the resulting frequency deviation of the radio data system irrespective of the
audio signals.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:DEViation on page 68

DARC
Requires "Mode > Stereo".
Enables/disables DARC.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:DARC[:STATe] on page 87

Freq. Dev. DARC
Requires "Mode > Stereo" and "DARC > On".
Sets the DARC frequency deviation.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:DARC:DEViation on page 87

4.3  RDS/RBDS settings

Requires "Baseband > Audio FM > FM Modulator > Mode > Stereo" and "Baseband >
Audio FM > FM Modulator > RDS/RDBS > On".

Access:

► Select "Baseband > Audio FM > RDS/RDBS".

The dialog provides general, MS, DI and CT RDS/RBDS settings.

The integrated RDS coder provides a versatile and flexible means of generating an
RDS data stream. It enables data for all the important group types to be entered as
menu inputs.

For group types provided for ODA, see Chapter 4.6.2, "Open format settings",
on page 51. You can define the data content of blocks 2, 3 and 4 using hexadecimal
input. The all-purpose input design means that there is no need to distinguish between
RDS and RBDS.

RDS/RBDS settings
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Settings:

● General settings......................................................................................................28
● MS/DI/CT settings...................................................................................................32

4.3.1  General settings

Access:

► Select "RDS/RDBS > General".

The tab provides general settings necessary to configure the RDS.

Settings:

Group Sequence........................................................................................................... 28
PI...................................................................................................................................29
PS................................................................................................................................. 29
TP..................................................................................................................................30
TA..................................................................................................................................30
PTY............................................................................................................................... 30
PTYN.............................................................................................................................30
RT..................................................................................................................................31
MS.................................................................................................................................31

Group Sequence
Defines the group sequence, that specifies the order of groups.
The group sequence is mandatory within the RDS data. The input field accepts up to
38 groups. A group consists of a group number and a version ("0A" to "15B"). Separate
groups by setting a comma or a space.
If you enter a group number without specifying version A or B, the software adds ver-
sion A automatically.

RDS/RBDS settings
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The RDS/RBDS transmission rate is approximately 11.4 group types per second. For
this reason, the repetition rate per time unit is determined decisively from the group
sequence inputs.
Note: Settings on the "RDS/RBDS" tab only take effect, if you enter the related group
in the group sequence.
Once the entered groups have been fully transmitted, the group sequence is repeated.
"4A" Requires "MS/DI/CT > CT > On".

Reserved group. Inserts the current CT automatically at each full
minute.

"14B" Reserved group for appropriate EON setting. The group is automati-
cally sent 8 times.
For more information, see specification EN 62106.

"15A" Reserved group for ODA.
"15B" Reserved group for appropriate setting. The group is automatically

sent 8 times.
For more information, see specification EN 62106.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:GROup:SEQuence on page 68

PI
Sets the program identification, that is a 16-bit value in hexadecimal representation.
The usage differs for RDS and RBDS operation:
● RDS: The PI consists of a code enabling the receiver to distinguish between coun-

tries and regions in that the same program is transmitted, and the programs them-
selves.
It 16-bit value comprises the country code (bit 15 to bit 12), the program type (bit 11
to bit 8) and the program reference number (bit 7 to bit 0).

● RBDS: In North America, the program identification code is used differently. In part,
the broadcasting stations define the program identification code themselves.
The PI is transmitted in each group type. For A group types, the PI is transmitted in
block 1. For B group types, it is transmitted in block 1 and block 3.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:PI on page 69

PS
Sets the program service name.
Group types "0A" or "0B" transmit the PS in addition to the PI. The PS is transmitted in
block 4 in both version A and version B.
You can enter an 8-character PS code, e.g. "R&S SMCV". For allowed character sets,
see Figure A-1.
Note: Not all receivers can display the full character set. For an overview of the dis-
played information, see Table A-1 and Table A-2.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:PS on page 69

RDS/RBDS settings
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TP
Enable/disables the traffic program flag.
A program carries regular traffic reports and is identified by the TP bit. It specifies, that
TA is set, if a traffic announcement occurs. The information is transmitted in block 2 of
each group.
If enabled, the "TA" can identify traffic announcements.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TP[:STATe] on page 70

TA
Enables/disables the traffic announcement flag.
If enabled, transmits the TA in block 2 of group types "0A", "0B" and "15B" to identify a
traffic announcement.
If the TA is set or reset, group type "15B" is transmitted 8 times to guarantee transmis-
sion, even if difficult reception conditions are present.
Table 4-2: Implication of TP/TA combinations

TP TA Implication

"Off" "Off" The program contains no traffic program.

"Off" "On" The program points to EON on a transmitter with traffic program.

Required setting for EON.

"On" "Off" The program provides a TP and sets TA to 1, if a traffic announcement
occurs.

"On" "On" A regular traffic announcement is indicated.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TA on page 70

PTY
Sets the program type.
The program type refers to the transmission content identifier and is transmitted in
block 2 of each group type. 32 possible program types are defined (0 to 31). After
entering the number, the assigned program type is displayed.
For RDS and RBDS, different group types are available, see Table A-1 and Table A-2.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:PTY on page 69

PTYN
Sets the program type name.
The PTYN allows you to specify the PTY. For example, for RDS "PTY > 4" implies a
"Sport" program, that you can further specify by "Football".
PTYN is optional and is transmitted in group type "10A", blocks 3 and 4. PTYN is only
transmitted if group type "10A" is specified in "Group Sequence".
You can enter an 8-character PTYN. For allowed character sets, see Figure A-1.
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Note: Not all receivers can display the full character set. For an overview of the dis-
played information, see Table A-1 and Table A-2.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:PTYN on page 69

RT
Sets the radio text.
RT comprises data messages transmitted in the following group types:
● Group type "2A": Up to 64 characters transmitted in blocks 3 and 4
● Group type "2B": Up to 32 characters transmitted in block 4
Use characters as shown in Figure A-1. It takes 16 group types "2A" to transmit
64 characters (eight characters per group type). Transmission can take time, if there
are several group types specified in "Group Sequence".
Further input inverts the A/B text flag in group type "2A" block 1 or "2B" block 2, signal-
ing to the receiver that another RT is being carried. Sending the RT requires group
type "2A" or "2B" specified in "Group Sequence".
If more than 32 characters are entered and group type "2B" is specified under "Group
Sequence", the radio text is transmitted as far as the 32nd character and the rest of the
characters are ignored. An error message is displayed.
Note: Not all receivers can display the full character set. For an overview of the dis-
played information, see Table A-1 and Table A-2.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:RT on page 70

MS
Identifies if the transmission contains music or speech.
Use the MS flag to actuate different volume settings in the receiver depending on the
MS. The flag is transmitted in group types "0A", "0B" and "15B". Also, set "Group
Sequence > 0A,0B" to transmit MS information via group types "0A" and "0B".
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:MS on page 69
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4.3.2  MS/DI/CT settings

Access:

► Select "RDS/RDBS > MS/DI/CT".

The tab provides settings necessary to configure decoder identification and clock
time parameters.

Settings:

DI Dynamic PTY............................................................................................................32
DI Compressed............................................................................................................. 32
DI Art. Head.................................................................................................................. 33
DI Stereo....................................................................................................................... 33
CT................................................................................................................................. 33
CT Offset.......................................................................................................................33

DI Dynamic PTY
Enables/disables dynamic PTY decoder identification.
For DI, the functionality allows dynamic toggling of the PTY of the current program or
the program referenced via EON in group type "14A", variant 13.
DI is transmitted in group types "0A", "0B" and "15B". Also, set "Group Sequence >
0A,0B" to transmit MS information via group types "0A" and "0B".
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:DYNamic on page 72

DI Compressed
Enables/disables compressed decoder identification.
For DI, the functionality allows transmission with compressed content. The content
belongs to the current program or the program referenced via EON in group type
"14A", variant 13.
DI is transmitted in group types "0A", "0B" and "15B". Also, set "Group Sequence >
0A,0B" to transmit MS information via group types "0A" and "0B".
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:COMPressed on page 71
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DI Art. Head
Enables/disables "artificial head" decoder identification.
For DI, the functionality uses artificial head or dummy head transmission of the pro-
gram. The program denotes the current program or the program referenced via EON in
group type "14A", variant 13.
DI is transmitted in group types "0A", "0B" and "15B". Also, set "Group Sequence >
0A,0B" to transmit MS information via group types "0A" and "0B".
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:ARTificial on page 71

DI Stereo
Enables/disables stereo decoder identification.
For DI, the functionality uses mono or stereo transmission of the program. The pro-
gram denotes the current program or the program referenced via EON in group type
"14A", variant 13.
DI is transmitted in group types "0A", "0B" and "15B". Also, set "Group Sequence >
0A,0B" to transmit MS information via group types "0A" and "0B".
"On" Stereo transmission
"Off" Mono transmission
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:STEReo on page 72

CT
Enables/disables the clock time and date information.
The time and date are transmitted in universal time coordinated format (UTC) together
with the local offset, and in modified Julian day format (MJD).
CT information is transmitted every full minute. For this purpose, the RDS/RBDS coder
deduces date and time information and the set time zone from the operating system
time.
For testing, change the CT by setting the "CT Offset".
"On" Transmits time information in group type "4A".
"Off" Group type "4A" is not transmitted.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:CT on page 71

CT Offset
Sets the clock time offset.
For certain test transmissions, you can add an offset to the set system time and time
zone. Adding the CT offset can be useful for transmissions of certain events on the
TMC and for setting their duration.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:CTOFfset on page 71

RDS/RBDS settings



Audio FM configuration and settingsR&S®SMCVB-K155

34User Manual 1179.1012.02 ─ 05

4.4  AF settings

Requires "Baseband > Audio FM > FM Modulator > Mode > Stereo" and "Baseband >
Audio FM > FM Modulator > RDS/RDBS > On".

Access:

► Select "Baseband > Audio FM > AF".

The tab provides settings necessary to configure alternative frequencies list (AF)
parameters.

AF gives information about which transmitters are broadcasting the same program in
the same or adjacent reception areas. Af also enables receivers with a corresponding
memory to reduce switchover times to another transmitter difficult reception conditions.

Settings:

AF Method.....................................................................................................................34
Num. of Frequencies.....................................................................................................36
Frequency table............................................................................................................ 37

└ Frequency.......................................................................................................37
Num. of Lists................................................................................................................. 37
Select Editlist.................................................................................................................37
Num. of Frequencies.....................................................................................................37
Tuning Frequency......................................................................................................... 38
Frequency  Order table................................................................................................. 38

└ Frequency.......................................................................................................38
└ Order...............................................................................................................38

AF Method
Sets the AF method.
For RDS/RBDS, two methods exist to transmit the AF.

AF settings
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"A" A list can specify up to 25 entries referenced to the transmission fre-
quency. The list includes the frequencies in the same transmitter net-
work that are carrying the same program and are located within a cer-
tain geographical area.
The frequencies are transmitted using group type "0A".
The actual number of frequencies, follows, is sent first, and then the
alternative frequencies. Every frequency is transmitted with the aid of
an 8-bit  code, see Table A-3 and Table A-4.
Frequencies from the LW and MW bands are not supported.

Example: Applying method A
5 frequencies are transmitted as alternatives to the current transmis-
sion frequency.

3 groups of group type "0A" are needed for this information.

1st group type 0A #5 AF1

2nd group type 0A AF2 AF3

3rd group type 0A AF5 AF5

AF settings
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"B" Alternative frequencies are transmitted using method B in the follow-
ing cases:
● The transmitter and its associated repeaters have more than 25

alternative frequencies.
● Several local regions have different program content.
In such cases, the respective alternative frequencies are transmitted
as alternatives to several transmission frequencies. Frequency infor-
mation is transmitted in the form of frequency pairs, giving the set
transmission frequency and the associated alternative frequency in
each case.
The sequence of the frequencies is important in this method. Some-
time the higher frequency is transmitted first, which refers to a fre-
quency having the same program content (ascending). If the lower
frequency is transmitted first, a regional variant using the alternative
frequency is being transmitted (descending).
Frequencies from the LW and MW bands are not supported.

Example: Applying method B
A list containing 5 different alternative frequencies is transmitted
using method B.

Block 3 of the first group type "0A" specifies the number of frequen-
cies that follow and the transmission frequency to which the alterna-
tive frequencies are referenced. The number of frequencies to follow
is therefore 11.

1st group type 0A #11 89.3

2nd group type 0A 89.3 99.5

3rd group type 0A 89.3 101.7

4th group type 0A 88.8 89.3

5th group type 0A 102.6 89.3

6th group type 0A 89.3 89.0

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:METHod on page 73

Num. of Frequencies
Requires "AF Method > A".
Defines the number of alternative frequencies.
You can transmit a maximum of 26 code words including the information on the num-
ber of frequencies that follow, before the transmission is repeated.
"0" Code 0xE0CD is transmitted in block 3 of group "0A". E0 means that

no alternative frequencies are available, see Table A-3 and Table A-4.
CD is a "filler code".

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:NUMBer on page 73
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Frequency table
Displays alternative frequency number AF <num> and frequency of up to 26 alterna-
tive frequencies in a table using AF method A.
The number of lines in the frequency table corresponds to the set number of frequen-
cies, see "Num. of Frequencies" on page 36.
Frequencies from the LW and MW bands are not supported.
Note: If you use the rotary knob to change an alternative frequency, an ENTER is
transmitted with every list item. The mechanism causes unwanted frequency informa-
tion to be transmitted.
If using the rotary knob remains your preferred input method, remove group type "0A"
from the group sequence beforehand.

Frequency ← Frequency table
Sets the frequency of the corresponding AF number.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:FREQuency<ch>? on page 73

Num. of Lists
Requires "AF Method > B".
Defines the number of lists of frequencies used for method B. You can set maximum
five lists.
"0" Code 0xE0CD is transmitted in block 3 of group "0A". E0 means that

no alternative frequencies are available, see Table A-3 and Table A-4.
CD is a "filler code".

Select Editlist
Selects the list, that is displayed in the "Fequency | Order" table, see "Frequency 
Order table" on page 38.

Num. of Frequencies
Defines the number of individual frequencies for each list of up to five lists. In
method B, transmission is not identified in the RDS coder.
The receiver is able to recognize this method by the tuning frequency contained in
each frequency pair, see "Tuning Frequency" on page 38.
"0" The list is ignored.
"12" A maximum of 26 code words is transmitted, including the information

on the tuning frequency and the number of frequencies that follow,
before the transmission is repeated.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:NUMBer on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:NUMBer on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:NUMBer on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:NUMBer on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:NUMBer on page 74
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Tuning Frequency
Defines the tuning frequency. The specified tuning frequency is transmitted to form a
frequency pair with each entered frequency.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:TFRequency on page 75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:TFRequency on page 75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:TFRequency on page 75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:TFRequency on page 75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:TFRequency on page 75

Frequency  Order table
For the selected list, displays alternative frequency number AF <num>, frequency and
order using AF method B.
The number of lines in the frequency table corresponds to the set number of frequen-
cies, see "Num. of Frequencies" on page 37.
The table also indicates whether the specified alternative frequency carries a different
regional program.

Frequency ← Frequency  Order table
Sets the frequency of the corresponding AF number of the selected list, see "Select
Editlist" on page 37.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:FREQuency<ch> on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:FREQuency<ch> on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:FREQuency<ch> on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:FREQuency<ch> on page 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:FREQuency<ch>?
on page 74

Order ← Frequency  Order table
Sets the frequency order of the corresponding AF number of the selected list, see
"Select Editlist" on page 37.
"Asc." Ascending order, the same program is carried.
"Desc." Descending order, the alternative frequency points to a program that

has regional variants.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:DESC<ch> on page 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:DESC<ch> on page 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:DESC<ch> on page 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:DESC<ch> on page 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:DESC<ch> on page 73
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4.5  EON settings

Access:

► Select "Baseband > Audio FM > EON".

The dialog provides enhanced other network settings.

EON-related information is used to update information saved in the receiver about pro-
grams other than the program being received (if other networks are enabled).

In addition to the alternative frequencies, program name, traffic program identification
and traffic announcement identification, you can also transmit the program type and
program contribution identification for all the other program chains.

Reference to each respective program is provided by the associated PI. The link infor-
mation enables the receiver to handle several program chains as a single chain during
shared program times.

Settings:

● General settings......................................................................................................39
● Method settings.......................................................................................................43

4.5.1  General settings

Access:

► Select "EON > General".

The tab provides settings necessary to configure general EON settings.

EON settings
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Settings:

EON PI.......................................................................................................................... 40
EON PS.........................................................................................................................40
EON TP.........................................................................................................................40
EON TA......................................................................................................................... 40
EON LA......................................................................................................................... 41
EON EG........................................................................................................................ 41
EON ILS........................................................................................................................ 41
EON LSN...................................................................................................................... 42
EON PTY...................................................................................................................... 42
EON PIN....................................................................................................................... 42

EON PI
Sets the enhanced other network program identification.
The PI code of the referenced transmitter is transmitted in group type "14A", block 4.
The PI code comprises a 16-bit value in hexadecimal representation.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PI on page 76

EON PS
Sets the enhanced other network program service name.
The PS is transmitted in group type "14A". For 8 characters, group type "14A" must be
transmitted 4 times. For allowed character sets, see Figure A-1.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PS on page 77

EON TP
Enables the enhanced other network traffic program.
If enabled, traffic announcements can be identified by "EON TA", see "EON TA"
on page 40.
An EON TP. carrying regular traffic reports, is identified by the traffic program bit. It
specifies that the TA is set, if a traffic announcement occurs.
The information is transmitted in group type "14A", block 2.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:TP on page 78

EON TA
Enables the enhanced other network traffic announcement.
If enabled, transmits the traffic announcement flag in block 3, variant 13 of group type
"14A" to identify a traffic announcement of an EON referenced program.
If the traffic announcement flag is set or reset, group type "14B" is transmitted 8 times
to guarantee transmission, even if difficult reception conditions are present.
Note: For EON, the signaling for the TP must be disabled and the TA must be enabled.
For details on implication of TP/TA combinations, see Table 4-2.
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Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:Ta on page 77

EON LA
Enables the enhanced other network linkage actuator.
"On" Transmits the linkage actuator bit in block 3, variant 12 of group

"14A". This bit informs the receiver that the program chain identified
by the PI (enabled) in block 4 of group type "14A" is linked to the pro-
gram combination referenced by the LSN.

"Off" Displays a possible future link.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LA on page 76

EON EG
Enables the enhanced other network extended generic indicator.
If enabled, the EG informs the receiver, that the program chain identified by the PI
(enabled) in block 4 of group type "14A" belongs to a group of related program chains.
These groups have interlinked services, but do not necessarily carry the same pro-
gram.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:EG on page 76

EON ILS
Enables the enhanced other network international linkage set indicator.
"On" Informs the receiver that an international link exists.

Figure 4-1: Structure of variant 12 of block 3 in group type 14A for international
linkage

For of an international linkage, the LSN must contain two elements.
● The CI: Bits b11 to b8 in block 3 must carry the country code of 1

or 2 participating countries.
● The LI - international linkage set number: Bits b7 to b0 are used

to link program chains internationally.
"Off" National linkage.

Figure 4-2: Structure of variant 12 of block 3 in group type 14A for national link-
age

EON settings
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Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:ILS on page 76

EON LSN
Sets the enhanced other network linkage set number.
The LSN is used to interlink two or more programs nationally or internationally. The
LSN comprises a 12-bit value in hexadecimal representation. The LSN code is trans-
mitted in block 3, variant 12 of group type "14A".

"000" Used to indicate an error situation in which two or more programs
with "EON LSN" = "000" are not linked to one another.

"≠000" If the programs that are intended to be linked to a group are identical,
"LA" is enabled (if "LA" = "On") or on standby (if "LA" = "Off"),
depending on the status of the linkage actuator, see also "EON LA"
on page 41.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LSN on page 76

EON PTY
Sets the enhanced other network program type.
The content identifier for the EON program transmission is called the program type and
is transmitted in group type "14A", block 3, variant 13.
A total of 32 possible program types (o to 31) are defined. After entering the appropri-
ate number, the assigned program type is displayed. For RDS and RBDS different
group types are available, see Table A-1 and Table A-2.
"31" Reserved for an alarm identifier. Any input that is not within the range

is rejected.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PTY on page 77

EON PIN
Sets the enhanced other network program item number.
The PIN code specifies the planned day, hour and minute for the start of the EON pro-
gram transmission, as published by the broadcaster. The PIN comprises 16-bit number
in hexadecimal representation as in Table 4-3.
Table 4-3: Format

D D D D D H H H H H M M M M M M

D = day, H = hour, M = minute

If you want to send an invalid PIN, set at least the day information bits DDDDD to zero.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PIN on page 77
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4.5.2  Method settings

Access:

► Select "EON > Method".

The tab provides settings necessary to configure EON alternative frequencies list
parameters.

Settings:

EON AF Method............................................................................................................43
Num. of Frequencies.....................................................................................................44
Frequency table............................................................................................................ 44

└ Frequency.......................................................................................................45
Num. of Frequencies.....................................................................................................45
Tuning Frequency......................................................................................................... 45
Frequency table............................................................................................................ 45

└ Frequency.......................................................................................................45

EON AF Method
Sets the AF method in an enhanced other network.
The alternative frequencies table gives information about the transmission frequencies
belonging to the program identification code in group type "14A", block 4.
Similar to alternative frequencies in the tuning network, for EON exist two methods for
transmitting the alternative frequencies.
Frequencies from the LW and MW bands are not supported.

EON settings



Audio FM configuration and settingsR&S®SMCVB-K155

44User Manual 1179.1012.02 ─ 05

"A" Yo can specify up to 25 frequencies referenced to the transmission
frequency. The frequencies are transmitted with group type "14A",
block 3, variant 4. The coding method is the same as for the alterna-
tive frequencies in group type "0A".
Specify number of frequencies and frequency values using EON AF
method A. See "Num. of Frequencies" on page 44 and "Frequency
table" on page 44.

"Mapped
Freq."

Similar to method B for coding the alternative frequencies in group
type "0A", a frequency pair is transmitted. Up to 4 frequency pairs are
transmitted in group type "14A", block 3, variants 5 to 8. The first fre-
quency (bit 15 to bit 8) corresponds to the transmission frequency of
the transmitter with the PI code in block 1. The second frequency
(bit 7 to bit 0) corresponds to the transmission frequency of the EON
service.
However, there is no sequence of lower and higher frequencies for
specifying local differences.
Variant 9 of group type "14A", block 3, with frequency codes from the
MW and LW bands, is not supported.
Specify number of frequencies, tuning frequency and mapped fre-
quency values using EON AF method "Mapped Freq.". See "Num. of
Frequencies" on page 45, "Tuning Frequency" on page 45 and
"Frequency table" on page 45.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:METHod on page 79

Num. of Frequencies
Requires "EON AF Method > A".
Defines the number of alternative frequencies.
You can transmit a maximum of 26 code words including the information on the num-
ber of frequencies that follow, before the transmission is repeated. Enter frequency val-
ues in the frequency table, see "Frequency table" on page 44.
"0" Code 0xE0CD is transmitted in block 3 of group "0A". E0 means that

no alternative frequencies are available, see Table A-3 and Table A-4.
CD is a "filler code".

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:NUMBer on page 78

Frequency table
Requires "EON AF Method > A".
Displays alternative frequency number AF <num> and frequency of up to 25 frequen-
cies referenced to the transmission frequency. The table includes the frequencies in
the same EON transmitter network that are carrying the same program and are located
within a certain geographical area.
The table includes the frequencies in the same EON transmitter network that are carry-
ing the same program and are located within a certain geographical area.
The number of lines in the frequency table corresponds to the set number of frequen-
cies, see "Num. of Frequencies" on page 44.
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The frequencies are transmitted with group type "14A", block 3, variant 4. The coding
method is the same as for the alternative frequencies in group type "0A".

Frequency ← Frequency table
Requires "EON AF Method > A".
Sets the frequency of the corresponding EON AF number for method A.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:FREQuency<ch> on page 78

Num. of Frequencies
Requires "EON AF Method > Mapped Freq.".
Defines the number of alternative frequencies.
"0" Variants 5 to 8 are not transmitted in group type "14A", block 3.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:FREQuency<ch> on page 78

Tuning Frequency
Requires "EON AF Method > Mapped Freq.".
Defines the tuning frequency. The specified tuning frequency is transmitted to form a
frequency pair with each entered frequency.
Defines the tuning frequency.
The specified tuning frequency is transmitted to form a frequency pair with each fre-
quency entered.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:TFRequency on page 79

Frequency table
Requires "EON AF Method > Mapped Freq.".
Displays alternative frequency number and frequency of up to 26 alternative frequen-
cies in a table.
The number of lines in the frequency table corresponds to the set number of frequen-
cies, see "Num. of Frequencies" on page 44.

Frequency ← Frequency table
Requires "EON AF Method > Mapped Freq.".
Sets the frequency of the corresponding EON AF number for AF mapped frequency
method.
Frequencies from the LW and MW bands are not supported.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:FREQuency<ch> on page 78
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4.6  TMC / open format settings

Access:

► Select "Baseband > Audio FM > TMC / Open F.".

The dialog provides settings necessary to configure traffic message channel
parameters and open format parameters for ODA.

Settings:

● TMC settings...........................................................................................................46
● Open format settings...............................................................................................51

4.6.1  TMC settings

Access:

► Select "TMC / Open F. > TMC".

The tab provides TMC settings.

Use the settings to send traffic messages as single group messages or multi group
messages.

A single group message is transmitted in one group type "8A", a multi group message
needs up to 5 group types "8A". It can take up to 6 group types "8A" to transmit the
tuning information.

TMC transmission is announced in group type "3A". We recommend that you send
group type "3A" at regular intervals.

TMC data messages are coded as specified in EN ISO 14819-1.

TMC / open format settings
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Settings:

TMC.............................................................................................................................. 47
Block 3 table..................................................................................................................47
Num. of 8A Groups (Hex)..............................................................................................48
Block 2 | Block 3 | Block 4.............................................................................................48
Apply............................................................................................................................. 50
Discard.......................................................................................................................... 50

TMC
Enables the traffic message channel.
"On" The data you entered is accepted.
"Off" The behavior depends on "Open Format", see "Open Format"

on page 51:
● "Open Format > On": If the "Group Sequence" includes group

types "3A" and "8A", the last 5 bits of block 2, as well as blocks 3
and 4, are filled up with zeros.

● "Open Format > Off": You can edit the group types "3A" and "8A"
without restriction.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC[:STATe] on page 81

Block 3 table
The settings in the table take effect, if "TMC > Off".
The table contains rows "Group 3A Var. 00" and "Group 3A Var. 01". Both parameters
comprise 16-bit values in hexadecimal representation.
In principle, group "3A" is sent in turn with variant 0 and variant 1. The input data is
held in block 3, see Table 4-4 and following sections.
The last 5 bits of block 2 are transmitted with the group application code "10000".
Block 4 of this group type is stuffed with 0xCD46. This code tells the receiver that the
following group types 8A contain TMC information.
Table 4-4: Contents of group 3A, block 3, variant 0

Y15 Y14 Y13 Y12 Y11 – Y6 Y5 Y4 Y3 Y2 Y1 Y0

0 0 X X LTN AFI M=0 I N R U

Table 4-5: Contents of group 3A, block 3, variant 1

Y15 Y14 Y13 - Y12 Y11 – Y6 Y5 - Y4 Y3 - Y2 Y1 - Y0

0 1 G SID X X X

TMC / open format settings
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Table 4-6: Parameters in block 3 and their meaning

Parameter Description Possible values

LTN Location table number 6 bits, see EN ISO 14819-3

AFI Alternative frequency indicator 1: All the frequencies in a transmitter network with the
same PI carry the same RDS TMC service.

0: Not all the frequencies in a transmitter network with the
same PI carry the same RDS TMC service.

M Transmission mode 0: Basic mode; Y5 to Y0 of variant 1 are irrelevant.

1: Enhanced mode; transmission of group types "8A" is
linked to fixed times (not supported).

I International (INTER-ROAD)  

N National  

R Regional  

U Urban  

G Gap parameter 00: At least 3 non-8A groups between 2 "8A" group types

01: At least 5 non-8A groups between 2 "8A" group types

10: At least 8 non-8A groups between 2 "8A" group types

11: At least 11 non-8A groups between 2 "8A" group types

SID Service identifier of the TMC
service

 

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G3A:VAR<ch> on page 80

Num. of 8A Groups (Hex)
Defines the number of TMC A8 groups.
The number comprises the total number of group types "8A" contained in blocks 2, 3
and 4, see "Block 2 | Block 3 | Block 4" on page 48.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A:NUMBer on page 81

Block 2 | Block 3 | Block 4
Defines the content of group types "8A".
It can hold 3 types of information.
● Single group message

Short traffic messages can be transmitted with a group type "8A".
Bit 3, block 2, in the group type "8A" is set to 1.
The single group message is identified by X4 = 0, X3 = 1.

TMC / open format settings
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Figure 4-3: TMC group type 8A: single group message

T = 0 = Indicates a user message
F = 1 = Indicates a single group message
DP = Duration and persistence value
D = 0 = Indicates that no diversion recommended
D = 1 = Indicates a recommended diversion
+/- = 0 = Indicates the positive direction
+/- = 1 = Indicates the negative direction

● Multi group message
Longer traffic messages need several group types "8A" for the traffic information. A
distinction is made between the 1st, 2nd, 3rd, 4th or 5th group type "8A".
The 1st group is identified by X4 = 0, X3 = 0, Y15 = 1.

Figure 4-4: TMC group type 8A: multi group message, first group

T = 0 = Indicates a user message
F = 0 = Indicates a multi group message
CI = Continuity index for distinguishing between the individual messages
+/- = 0 = Indicates the positive direction
+/- = 1 = Indicates the negative direction

Figure 4-5: TMC group type 8A: multi group message, second and subsequent groups

T = 0 = Indicates a user message
F = 0 = Indicates a multi group message
CI = Continuity index for distinguishing between the individual messages

TMC / open format settings
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SG = 0 = Indicates the 3rd, 4th or 5th group
SG = 1 = Indicates the 2nd group
GSI = Group sequence value

● Tuning information
This feature is not for transmitting the content of traffic messages. Instead it carries
general information about the TMC service, such as the service provider name, the
associated program identification, the assigned frequency and various system
parameters.

Figure 4-6: TMC group type 8A: tuning information

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk2 on page 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk3a on page 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk4 on page 81

Apply
Sends the TMC message.
Since it takes a certain amount of time to send a TMC message, during the transmis-
sion process, an hourglass symbol  is displayed left from the subtab name and the
"Apply" button.
When using remote control, it is particularly important to know whether a message that
has been entered has yet been transmitted and when a new TMC message can be
sent.
If the group types "3A" and "8A" are not included in the "Group Sequence", an error
message is displayed. The transmission stops until the group types "3A" and "8A" have
been entered.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:APPLy on page 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:READy? on page 81

Discard
Discards the configured group type 8A settings.
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Discarding triggers a reset of the following parameters:
● "Num. of 8A Groups (Hex)", see "Num. of 8A Groups (Hex)" on page 48.
● "Block 2 | Block 3 | Block 4", see "Block 2 | Block 3 | Block 4" on page 48
Remote command: 
n.a.

4.6.2  Open format settings

Access:

► Select "TMC / Open F. > Open F.""System > L1".

The tab provides settings necessary to configure open format parameters for ODA.

Settings:

Open Format................................................................................................................. 51
Block 2 | Block 3 | Block 4.............................................................................................52
Apply............................................................................................................................. 52
Discard.......................................................................................................................... 52

Open Format
Enables the open format.
"On" Sends the data entered in the "Block 2 | Block 3 | Block 4" table, see

"Block 2 | Block 3 | Block 4" on page 52.
"Off" Stuffs the group types with zeros. Stuffing is performed for group

types specified in "Group Sequence", see "Group Sequence"
on page 28.

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF[:STATe] on page 82
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Block 2 | Block 3 | Block 4
Contains all group types specified in the RDS/RBDS group sequence.
See "Group Sequence" on page 28.
In A group types, blocks 2, 3 and 4 can be described using hexadecimal data. In
block 2, last 5 bits are used; in blocks 3 and 4, 16 bits are used.
In B group types, block 3 cannot be described, because in the group types the program
identification is automatically entered.
If "TMC > Off", you can only edit the group types "3A" and "8A".
After entering the desired data, press "Apply".
"Block 2" col-
umn

8-bit value in hexadecimal representation.

"Block 3" col-
umn

Only available for group types A. 16-bit value in hexadecimal repre-
sentation.

"Block 4" col-
umn

16-bit value in hexadecimal representation.

Remote command: 
Block 2 commands:
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk2 on page 83 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk2 on page 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk2 on page 83 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk2 on page 83
Block 3 commands:
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk3 on page 84 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk3 on page 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk3? on page 84 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk3? on page 85
Block 4 commands:
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk4 on page 85 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk4 on page 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk4 on page 86 to [:
SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk4 on page 86

Apply
If group types are part of the "Group Sequence", clicking "Apply" triggers transmission
start.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:APPLy on page 82

Discard
Discards the configured group type 8A settings.
Discarding triggers a reset of the parameters in table "Block 2 | Block 3 | Block 4", see
"Block 2 | Block 3 | Block 4" on page 52.
Remote command: 
n.a.
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4.7  DARC settings

Requires "Baseband > Audio FM > FM Modulator > Mode > Stereo" and "Baseband >
Audio FM > FM Modulator > DARC" "> On".

Access:

► Select "Baseband > Audio FM > DARC".

The dialog provides DARC settings.

Settings:

Information.................................................................................................................... 53
Data BIC 1/2/3...............................................................................................................53

Information
Sets the information type, that is transmitted for DARC operation in line with specifica-
tion EN 300 751.
"Off" No information type transmitted.
"PRBS" PRBS data
"Data" Data as specified in "Data BIC 1/2/3".
Remote command: 
[:SOURce<hw>]:BB:RADio:FM:DARC:INFormation on page 87

Data BIC 1/2/3
Specifies data for block identification codes 1 to 3.

Example: 
"Data BIC 1 = Rohde & Schwarz"
"Data BIC 2 = Signal Generator"
"Data BIC 1 = SMCV100B"

Remote command: 
[:SOURce<hw>]:BB:RADio:FM:DARC:BIC<ch> on page 86

DARC settings
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4.8  Special settings

Access:

► Select "Baseband > Audio FM > Special".

The tab provides settings, that differ from the specification of the broadcast stan-
dard.

Settings different from the broadcast standard can be useful for research and develop-
ment. Applying these settings requires "Special Settings > On".
If you set a parameter different from the specification, the warning icon  is displayed
to the left of the parameter.

Settings:

Special Settings............................................................................................................ 54
Pilot............................................................................................................................... 54
Phase Offset Pilot..........................................................................................................54
Phase Offset RDS.........................................................................................................55

Special Settings
Enables/disables special settings.
The setting allows you to switch between standard-compliant and user-defined channel
coding.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:SETTings[:STATe] on page 88

Pilot
Enables/disables the 19 kHz pilot tone.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot[:STATe] on page 88

Phase Offset Pilot
Sets the phase offset of the 19 kHz pilot tone.
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Applying the phase offset requires "Pilot > On". The offset is applied relative to the sup-
pressed 38 kHz carrier with an accuracy of 0.1 deg.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot:PHASe on page 87

Phase Offset RDS
Sets the phase offset of the suppressed 57 kHz RDS carrier.
Applying the phase offset requires "FM Modulator > Modulation > RDS/RBDS > On".
The offset is applied relative to the suppressed 38 kHz carrier with an accuracy of
0.1 deg.
The reference point is the 19 kHz pilot tone with a phase shift setting of 0.0 deg.
Remote command: 
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:RDS:PHASe on page 88

Special settings
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5  Global connector settings
The "Input Signal" dialog, the "Trigger/Marker/Clock" dialog and "Trigger In", "Marker"
and "Clock" tabs in "Baseband > ARB/Custom Digital Mod" configuration dialogs pro-
vide quick access to the related connector settings. Click the "Global Connectors" but-
ton to access the settings.

See also chapter "Global connector settings" in the user manual.



Remote-control commandsR&S®SMCVB-K155

57User Manual 1179.1012.02 ─ 05

6  Remote-control commands
The following commands are required to generate signals with the AM/FM/RDS option
in a remote environment. We assume that the R&S SMCV100B has already been set
up for remote operation in a network as described in the R&S SMCV100B documenta-
tion. A knowledge about the remote control operation and the SCPI command syntax
are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote-Control Commands" in the R&S SMCV100B user manual.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals

Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument preset/reset is rec-
ommended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The following commands specific to the AM/FM/RDS are described here:

● Audio AM commands..............................................................................................58
● Audio FM commands.............................................................................................. 62
● FM RDS general commands...................................................................................68
● FM RDS CT/DI commands..................................................................................... 71
● FM RDS AF method commands............................................................................. 72
● FM RDS EON commands.......................................................................................75
● FM RDS TMC commands.......................................................................................79
● FM RDS OPF commands....................................................................................... 81
● DARC commands................................................................................................... 86
● FM special commands............................................................................................ 87
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6.1  Audio AM commands

● General commands.................................................................................................58
● Modulation commands............................................................................................59

6.1.1  General commands

[:SOURce<hw>]:BB:RADio:AM:PRESet............................................................................. 58
[:SOURce<hw>]:BB:RADio:AM:STATe............................................................................... 58
[:SOURce<hw>]:BB:RADio:AM:SETTing:CATalog............................................................... 58
[:SOURce<hw>]:BB:RADio:AM:SETTing:DELete.................................................................59
[:SOURce<hw>]:BB:RADio:AM:SETTing:LOAD...................................................................59
[:SOURce<hw>]:BB:RADio:AM:SETTing:STORe.................................................................59

[:SOURce<hw>]:BB:RADio:AM:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command
SOURce<hw>:BB:AM|FM|FM:RDS:STATe.

Usage: Event

Manual operation: See "Set To Default" on page 12

[:SOURce<hw>]:BB:RADio:AM:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 12

[:SOURce<hw>]:BB:RADio:AM:SETTing:CATalog

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.am/fm/rds.

Return values: 
<AmCat> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Manual operation: See "Save/Recall" on page 13
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[:SOURce<hw>]:BB:RADio:AM:SETTing:DELete <AmDel>

Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.am/fm/rds.

Setting parameters: 
<AmDel> "<filename>"

Filename or complete file path; file extension can be omitted

Usage: Setting only

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:RADio:AM:SETTing:LOAD <AmRcl>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.am/fm/rds.

Parameters:
<AmRcl> "<filename>"

Filename or complete file path; file extension can be omitted

Manual operation: See "Save/Recall" on page 13

[:SOURce<hw>]:BB:RADio:AM:SETTing:STORe <AmSav>

Saves the current settings into the selected file; the file extension (*.am/fm/rds) is
assigned automatically.

Parameters:
<AmSav> "<filename>"

Filename or complete file path

Manual operation: See "Save/Recall" on page 13

6.1.2  Modulation commands

[:SOURce<hw>]:BB:RADio:AM:APLayer:ATT......................................................................59
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:CATalog...................................................60
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:SELect.................................................... 60
[:SOURce<hw>]:BB:RADio:AM:AUDGen:FRQ.................................................................... 60
[:SOURce<hw>]:BB:RADio:AM:AUDGen:LEV.....................................................................60
[:SOURce<hw>]:BB:RADio:AM:AUDio:AF.......................................................................... 61
[:SOURce<hw>]:BB:RADio:AM:DEPTh.............................................................................. 61
[:SOURce<hw>]:BB:RADio:AM:INPut.................................................................................61
[:SOURce<hw>]:BB:RADio:AM:MODulation:DEPTh?.......................................................... 61
[:SOURce<hw>]:BB:RADio:AM:SOURce............................................................................62

[:SOURce<hw>]:BB:RADio:AM:APLayer:ATT <Attenuation>

Sets the attenuation.
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Parameters:
<Attenuation> float

Range: 0  to  30
Increment: 0.01
*RST: 0

Manual operation: See "Attenuation" on page 16

[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:CATalog

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.wv and *.wav.

Manual operation: See "Load File" on page 15

[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:SELect <SEL>

Selects the audio file. If no file of the specified name exists, an error message is dis-
played. You can select files with the file extension *.wv and *.wav.

Parameters:
<SEL> string

Filename or complete file path; file extension can be omitted

Manual operation: See "Load File" on page 15

[:SOURce<hw>]:BB:RADio:AM:AUDGen:FRQ <Freq>

Sets the frequency.

Parameters:
<Freq> float

Range: 0.03  to  15
Increment: 0.001
*RST: 1
Default unit: kHz

Manual operation: See "Frequency" on page 15

[:SOURce<hw>]:BB:RADio:AM:AUDGen:LEV <Level>

Sets the level.

Parameters:
<Level> float

Range: -60  to  12
Increment: 0.01
*RST: 6
Default unit: dBu

Manual operation: See "Level" on page 15
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[:SOURce<hw>]:BB:RADio:AM:AUDio:AF <Audio>

Enables or disables the audio channel.

Parameters:
<Audio> 1 | ON | 0 | OFF

*RST: 1

Manual operation: See "Audio" on page 14

[:SOURce<hw>]:BB:RADio:AM:DEPTh <Depth>

Sets the nominal modulation depth.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.01
*RST: 30

Manual operation: See "Nom. Mod. Depth" on page 17

[:SOURce<hw>]:BB:RADio:AM:INPut <Input>

Sets the audio source for the AM modulator signal.

Parameters:
<Input> EXTernal | AGENerator | APLayer | OFF

EXTernal
Uses an external audio signal input at the "User 2" connector.
The audio source is fixed to "Source > S/PDIF", see [:
SOURce<hw>]:BB:RADio:AM:SOURce on page 62.
AGENerator
Uses an internal audio generator as the signal source.
APLayer
Uses an audio player file, that is saved to the memory of the
R&S SMCV100B.
OFF
Disables the audio source for the AM modulator.
*RST: AGENerator

Manual operation: See "Input Signal" on page 14

[:SOURce<hw>]:BB:RADio:AM:MODulation:DEPTh?

Displays the modulation depth.
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Return values: 
<ModDepth> integer

Range: 0  to  100
*RST: 30

Usage: Query only

Manual operation: See "Mod. Depth" on page 17

[:SOURce<hw>]:BB:RADio:AM:SOURce <Source>

Queries the audio source.

Parameters:
<Source> SPDif

S/PDIF is fixed.
*RST: SPDif

Manual operation: See "Source" on page 16

6.2  Audio FM commands

● General commands.................................................................................................62
● Modulation commands............................................................................................64

6.2.1  General commands

[:SOURce<hw>]:BB:RADio:FM:PRESet............................................................................. 62
[:SOURce<hw>]:BB:RADio:FM:STATe................................................................................63
[:SOURce<hw>]:BB:RADio:FM:SETTing:CATalog................................................................63
[:SOURce<hw>]:BB:RADio:FM:SETTing:DELete.................................................................63
[:SOURce<hw>]:BB:RADio:FM:SETTing:LOAD...................................................................63
[:SOURce<hw>]:BB:RADio:FM:SETTing:STORe.................................................................63

[:SOURce<hw>]:BB:RADio:FM:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command
SOURce<hw>:BB:AM|FM|FM:RDS:STATe.

Usage: Event

Manual operation: See "Set To Default" on page 19
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[:SOURce<hw>]:BB:RADio:FM:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "State" on page 18

[:SOURce<hw>]:BB:RADio:FM:SETTing:CATalog <FmCat>

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.am/fm/rds.

Return values: 
<FmCat> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:RADio:FM:SETTing:DELete <FMDel>

Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.am/fm/rds.

Setting parameters: 
<FMDel> "<filename>"

Filename or complete file path; file extension can be omitted

Usage: Setting only

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:RADio:FM:SETTing:LOAD <FmRcl>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.am/fm/rds.

Parameters:
<FmRcl> "<filename>"

Filename or complete file path; file extension can be omitted

Manual operation: See "Save/Recall" on page 19

[:SOURce<hw>]:BB:RADio:FM:SETTing:STORe <FmSav>

Saves the current settings into the selected file; the file extension (*.am/fm/rds) is
assigned automatically.
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Parameters:
<FmSav> "<filename>"

Filename or complete file path

Manual operation: See "Save/Recall" on page 19

6.2.2  Modulation commands

[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT1....................................................................64
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT2....................................................................64
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:CATalog...................................................64
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:SELect.....................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ1.................................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ2.................................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV1................................................................... 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV2................................................................... 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF1.........................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF2.........................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDio:DEViation?.............................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:MODE.....................................................................66
[:SOURce<hw>]:BB:RADio:FM:AUDio:NDEViation..............................................................66
[:SOURce<hw>]:BB:RADio:FM:AUDio:PREemphasis.......................................................... 66
[:SOURce<hw>]:BB:RADio:FM:AUDio:SOURce?................................................................ 66
[:SOURce<hw>]:BB:RADio:FM:INPut.................................................................................67
[:SOURce<hw>]:BB:RADio:FM:MODE............................................................................... 67
[:SOURce<hw>]:BB:RADio:FM:PILot:DEViation.................................................................. 68

[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT1 <ATTL>
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT2 <ATTR>
Sets the attenuation.

Parameters:
<ATTR> float

Range: 0  to  30
Increment: 0.01
*RST: 0
Default unit: dB

Manual operation: See "Attenuation" on page 22

[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:CATalog

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.wv and *.wav.

Manual operation: See "Load File" on page 24

Audio FM commands



Remote-control commandsR&S®SMCVB-K155

65User Manual 1179.1012.02 ─ 05

[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:SELect <SEL>

Selects the audio file. If no file of the specified name exists, an error message is dis-
played. You can select files with the file extension *.wv and *.wav.

Parameters:
<SEL> string

Filename or complete file path; file extension can be omitted

Manual operation: See "Load File" on page 24

[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ1 <FreqL>
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ2 <FreqR>
Sets the frequency.

Parameters:
<FreqR> integer

Range: 30  to  15000
*RST: 1000
Default unit: Hz

Manual operation: See "Frequency" on page 22

[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV1 <LevelL>
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV2 <LevelR>
Sets the level.

Parameters:
<LevelR> float

Range: -60  to  12
Increment: 0.01
*RST: 6
Default unit: dBu

Manual operation: See "Level" on page 22

[:SOURce<hw>]:BB:RADio:FM:AUDio:AF1 <AudioL>
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF2 <AudioR>
Enables or disables the audio channel.

Parameters:
<AudioR> 1 | ON | 0 | OFF

*RST: 1

Manual operation: See "Audio" on page 21

[:SOURce<hw>]:BB:RADio:FM:AUDio:DEViation?

Queries the actual frequency deviation.
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Return values: 
<FreqDevAudio> float

Range: 0  to  999.99
Increment: 0.01
*RST: 0
Default unit: kHz

Usage: Query only

Manual operation: See "Freq. Dev. Audio" on page 26

[:SOURce<hw>]:BB:RADio:FM:AUDio:MODE <AFMode>

Sets the relationship of the two audio channels with respect to each other.

Parameters:
<AFMode> LEFT | RIGHt | RELeft | REMLeft | RNELeft

*RST: LEFT

Manual operation: See "AF Mode" on page 21

[:SOURce<hw>]:BB:RADio:FM:AUDio:NDEViation <MonFreqDevAudio>

Defines the signal deviation, that is the deviation only caused by the audio signals.

Parameters:
<MonFreqDevAudio> float

Range: 0  to  100
Increment: 0.001
*RST: 40
Default unit: kHz

Manual operation: See "Nom. Freq. Dev. Audio" on page 26

[:SOURce<hw>]:BB:RADio:FM:AUDio:PREemphasis <Preemphasis>

Sets the preemphasis factor for the signal to noise ratio improvement.

Parameters:
<Preemphasis> OFF | D50us | D75us

*RST: D50us

Manual operation: See "Preemphasis" on page 26

[:SOURce<hw>]:BB:RADio:FM:AUDio:SOURce?

Queries the audio source.
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Return values: 
<Source> SPDif

S/PDIF is fixed.
*RST: SPDif

Usage: Query only

Manual operation: See "Source" on page 25

[:SOURce<hw>]:BB:RADio:FM:INPut <Input>

Sets the audio source for the FM modulator signal.

Parameters:
<Input> EXTernal | AGENerator | APLayer | OFF

EXTernal
Uses an external audio signal input at the "User 2" connector.
The audio source is fixed to "Source > S/PDIF", see [:
SOURce<hw>]:BB:RADio:FM:AUDio:SOURce? on page 66.
AGENerator
Uses an internal audio generator as the signal source.
APLayer
Uses an audio player file, that is saved to the memory of the
R&S SMCV100B.
OFF
Disables the audio source for the FM modulator.
*RST: AGENerator

<Input> OFF | APLayer | AGENerator | EXTernal
*RST: AGENerator

Manual operation: See "Input Signal" on page 20

[:SOURce<hw>]:BB:RADio:FM:MODE <Mode>

Sets the FM mode.

Parameters:
<Mode> MONO | STEReo

MONO
Feeds a mono signal to the modulator with band limitation
15 kHz.
STEReo
Feeds a stereo signal to the modulator.
*RST: STEReo

Manual operation: See "Mode" on page 26
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[:SOURce<hw>]:BB:RADio:FM:PILot:DEViation <FreqDevPilot>

Defines the resulting 19 kHz frequency deviation of the pilot tone irrespective of the
audio signals.

Parameters:
<FreqDevPilot> float

Range: 0  to  15
Increment: 0.01
*RST: 6.75
Default unit: kHz

Manual operation: See "Freq. Dev. Pilot" on page 26

6.3  FM RDS general commands

[:SOURce<hw>]:BB:RADio:FM:RDS:DEViation...................................................................68
[:SOURce<hw>]:BB:RADio:FM:RDS:GROup:SEQuence......................................................68
[:SOURce<hw>]:BB:RADio:FM:RDS:MS............................................................................ 69
[:SOURce<hw>]:BB:RADio:FM:RDS:PI.............................................................................. 69
[:SOURce<hw>]:BB:RADio:FM:RDS:PS.............................................................................69
[:SOURce<hw>]:BB:RADio:FM:RDS:PTY...........................................................................69
[:SOURce<hw>]:BB:RADio:FM:RDS:PTYN.........................................................................69
[:SOURce<hw>]:BB:RADio:FM:RDS:RT.............................................................................70
[:SOURce<hw>]:BB:RADio:FM:RDS:TA............................................................................. 70
[:SOURce<hw>]:BB:RADio:FM:RDS:TP[:STATe]................................................................. 70
[:SOURce<hw>]:BB:RADio:FM:RDS[:STATe]...................................................................... 70

[:SOURce<hw>]:BB:RADio:FM:RDS:DEViation <FreqDevRDS>

Defines the resulting frequency deviation of the radio data system irrespective of the
audio signals.

Parameters:
<FreqDevRDS> float

Range: 0  to  10
Increment: 0.01
*RST: 2
Default unit: kHz

Manual operation: See "Freq. Dev. RDS" on page 27

[:SOURce<hw>]:BB:RADio:FM:RDS:GROup:SEQuence <GroupSequence>

Parameters:
<GroupSequence> string

Manual operation: See "Group Sequence" on page 28
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[:SOURce<hw>]:BB:RADio:FM:RDS:MS <MS>

Identifies if the transmission contains music or speech.

Parameters:
<MS> MUSic | SPEech

*RST: MUSic

Manual operation: See "MS" on page 31

[:SOURce<hw>]:BB:RADio:FM:RDS:PI <PI>

Sets the program identification, that is a 16-bit value in hexadecimal representation.

Parameters:
<PI> integer

Range: #H0000  to  #HFFFF
*RST: #HFFFF

Manual operation: See "PI" on page 29

[:SOURce<hw>]:BB:RADio:FM:RDS:PS <PS>

Sets the program service name.

Parameters:
<PS> string

Up to eight characters in ASCII format, see Figure A-1.
*RST: "R&S SMCV"

Example: SOURce1:BB:RADio:FM:RDS:PS?
// Response: "R&S SMCV"

Manual operation: See "PS" on page 29

[:SOURce<hw>]:BB:RADio:FM:RDS:PTY <PTY>

Sets the program type.

Parameters:
<PTY> integer

Range: 0  to  31
*RST: 0

Manual operation: See "PTY" on page 30

[:SOURce<hw>]:BB:RADio:FM:RDS:PTYN <PTYN>

Sets the program type name.
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Parameters:
<PTYN> string

Up to eight characters in ASCII format, see Figure A-1.

Example: SOURce1:BB:RADio:FM:RDS:PTYN Football
Sets the program type name "Football".

Manual operation: See "PTYN" on page 30

[:SOURce<hw>]:BB:RADio:FM:RDS:RT <RT>

Sets the radio text.

Parameters:
<RT> string

*RST: "Rohde & Schwarz
Up to 64 characters in ASCII format, see Figure A-1.

Manual operation: See "RT" on page 31

[:SOURce<hw>]:BB:RADio:FM:RDS:TA <TA>

Enables/disables the traffic announcement flag.

Parameters:
<TA> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "TA" on page 30

[:SOURce<hw>]:BB:RADio:FM:RDS:TP[:STATe] <TP>

Enable/disables the traffic program flag.

Parameters:
<TP> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "TP" on page 30

[:SOURce<hw>]:BB:RADio:FM:RDS[:STATe] <RDSState>

Enables/disables RDS/RBDS.

Parameters:
<RDSState> 1 | ON | 0 | OFF

*RST: 1

Manual operation: See "RDS/RBDS" on page 27
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6.4  FM RDS CT/DI commands

[:SOURce<hw>]:BB:RADio:FM:RDS:CT.............................................................................71
[:SOURce<hw>]:BB:RADio:FM:RDS:CTOFfset................................................................... 71
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:ARTificial................................................................71
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:COMPressed..........................................................71
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:DYNamic............................................................... 72
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:STEReo.................................................................72

[:SOURce<hw>]:BB:RADio:FM:RDS:CT <CT>

Enables/disables the clock time and date information.

Parameters:
<CT> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "CT" on page 33

[:SOURce<hw>]:BB:RADio:FM:RDS:CTOFfset <CtOffset>

Sets the clock time offset.

Parameters:
<CtOffset> string

Range: 00:00  to  99:59
Increment: 00:01
*RST: 00:00

Example: SOURce1:BB:RADio:FM:RDS:CTOFfset 01:23:45
Sets a time offset of 1 hour, 23 minutes and 45 seconds to the
CT.

Manual operation: See "CT Offset" on page 33

[:SOURce<hw>]:BB:RADio:FM:RDS:DI:ARTificial <DiArtifical>

Enables/disables "artificial head" decoder identification.

Parameters:
<DiArtifical> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "DI Art. Head" on page 33

[:SOURce<hw>]:BB:RADio:FM:RDS:DI:COMPressed <DiCompressed>

Enables/disables compressed decoder identification.
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Parameters:
<DiCompressed> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "DI Compressed" on page 32

[:SOURce<hw>]:BB:RADio:FM:RDS:DI:DYNamic <DiDynamic>

Enables/disables dynamic PTY decoder identification.

Parameters:
<DiDynamic> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "DI Dynamic PTY" on page 32

[:SOURce<hw>]:BB:RADio:FM:RDS:DI:STEReo <DiStereo>

Enables/disables stereo decoder identification.

Parameters:
<DiStereo> 1 | ON | 0 | OFF

ON
Stereo transmission
OFF
Mono transmission
*RST: 0

Manual operation: See "DI Stereo" on page 33

6.5  FM RDS AF method commands

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:METHod............................................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:FREQuency<ch>?.............................................. 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:NUMBer.............................................................73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:DESC<ch>............................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:DESC<ch>............................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:DESC<ch>............................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:DESC<ch>............................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:DESC<ch>............................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:FREQuency<ch>.......................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:FREQuency<ch>.......................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:FREQuency<ch>.......................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:FREQuency<ch>.......................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:FREQuency<ch>?.....................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:NUMBer................................................... 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:NUMBer................................................... 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:NUMBer................................................... 74
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[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:NUMBer................................................... 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:NUMBer................................................... 74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:TFRequency.............................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:TFRequency.............................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:TFRequency.............................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:TFRequency.............................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:TFRequency.............................................75

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:METHod <AFMethod>

Parameters:
<AFMethod> B | A

*RST: A

Manual operation: See "AF Method" on page 34

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:FREQuency<ch>? <AFFreqA>

Sets the alternative frequencies in AF method A.

Suffix: 
<ch>

.
1 to 25
Selects the alternative frequency.

Parameters:
<AFFreqA> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: MHz

Manual operation: See "Frequency" on page 37

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:NUMBer <AFNumFreqA>

Defines the number of alternative frequencies.

Parameters:
<AFNumFreqA> integer

Range: 0  to  25
*RST: 0

Manual operation: See "Num. of Frequencies" on page 36

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:DESC<ch> <AfList1Order>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:DESC<ch> <AfList2Order>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:DESC<ch> <AfList3Order>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:DESC<ch> <AfList4Order>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:DESC<ch> <AfList5Order>
Sets the frequency order of the corresponding AF number of the selected list.
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Suffix: 
LIST<ch>

.
1 to 5
Select the list.

DESC<ch> 1 to 12
Selects the AF number.

Parameters:
<AfList5Order> ASC | DESC

ASC
Ascending order, the same program is carried.
DESC
Descending order, the alternative frequency points to a program
that has regional variants.
*RST: ASC

Manual operation: See "Order" on page 38

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:FREQuency<ch> <AfList1Freq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:FREQuency<ch> <AfList2Freq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:FREQuency<ch> <AfList3Freq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:FREQuency<ch> <AFList4Freq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:FREQuency<ch>? <AfList5Freq>
Sets an alternative frequency of a list in AF method B.

Suffix: 
LIST<ch>

.
1 to 5
Select the list.

FREQuency<ch> 1 to 12
Selects the AF number.

Parameters:
<AfList5Freq> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: 87.6
Default unit: MHz

Manual operation: See "Frequency" on page 38

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:NUMBer <AfBList1NoFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:NUMBer <AfBList2NoFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:NUMBer <AfBList3NoFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:NUMBer <AfBList4NoFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:NUMBer <AfBList5NoFreq>
Sets the number of frequencies of a list in AF method B.
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Suffix: 
LIST<ch>

.
1 to 5
Select the list.

Parameters:
<AfBList5NoFreq> integer

Range: 0  to  12
*RST: 0

Manual operation: See "Num. of Frequencies" on page 37

[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:TFRequency <AfList1TunFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:TFRequency <AfList2TunFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:TFRequency <AfList3TunFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:TFRequency <AfList4TunFreq>
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:TFRequency <AfList5TunFreq>
Sets the tuning frequency of a list in AF method B.

Suffix: 
LIST<ch>

.
1 to 5
Selects the list.

Parameters:
<AfList5TunFreq> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: 87.6
Default unit: MHz

Manual operation: See "Tuning Frequency" on page 38

6.6  FM RDS EON commands

● General commands.................................................................................................75
● Method commands..................................................................................................78

6.6.1  General commands

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:EG.....................................................................76
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:ILS.................................................................... 76
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LA..................................................................... 76
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LSN...................................................................76
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PI...................................................................... 76
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PIN....................................................................77
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PS.....................................................................77
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PTY...................................................................77
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:Ta......................................................................77
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:TP..................................................................... 78
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[:SOURce<hw>]:BB:RADio:FM:RDS:EON:EG <EonEG>

Enables the enhanced other network extended generic indicator.

Parameters:
<EonEG> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "EON EG" on page 41

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:ILS <EonILS>

Enables the enhanced other network international linkage set indicator.

Parameters:
<EonILS> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "EON ILS" on page 41

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LA <EonLA>

Enables the enhanced other network linkage actuator.

Parameters:
<EonLA> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "EON LA" on page 41

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:LSN <EonLSN>

Sets the enhanced other network linkage set number.

The LSN comprises a 12-bit value in decimal representation.

Parameters:
<EonLSN> integer

Range: 0  to  4095
*RST: 0

Manual operation: See "EON LSN" on page 42

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PI <EonPI>

Sets the enhanced other network program identification.

Parameters:
<EonPI> integer

Range: 0  to  65535
*RST: 65535
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Example: SOURce1:BB:RADio:FM:RDS:EON:PI 53539
Sets an EON PI of 0xD123 in hexadecimal representation.

Manual operation: See "EON PI" on page 40

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PIN <EonPIN>

Sets the enhanced other network program item number.

Parameters:
<EonPIN> integer

Range: 0  to  65535
*RST: 0

Example: SOURce1:BB:RADio:FM:RDS:EON:PIN 2688
Sets an EON PIN to to day = 1, hour = 10, minute = 0.

Manual operation: See "EON PIN" on page 42

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PS <EonPS>

Sets the enhanced other network program service name.

Parameters:
<EonPS> string

*RST: "Program1"

Manual operation: See "EON PS" on page 40

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:PTY <EonPTY>

Sets the enhanced other network program type.

Parameters:
<EonPTY> integer

Range: 0  to  31
*RST: 0

Manual operation: See "EON PTY" on page 42

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:Ta <EonTA>

Enables the enhanced other network traffic announcement.

Parameters:
<EonTA> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "EON TA" on page 40
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[:SOURce<hw>]:BB:RADio:FM:RDS:EON:TP <EonTP>

Enables the enhanced other network traffic program.

Parameters:
<EonTP> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "EON TP" on page 40

6.6.2  Method commands

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:FREQuency<ch>........................................ 78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:NUMBer.....................................................78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:FREQuency<ch>........................................ 78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:NUMBer.....................................................79
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:TFRequency...............................................79
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:METHod....................................................... 79

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:FREQuency<ch> <EonAFAFreq>

Sets the alternative frequencies in EON, AF method A.

Suffix: 
<ch>

.
1 to 25
Selects the alternative frequency.

Parameters:
<EonAFAFreq> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: 87.6
Default unit: MHz

Manual operation: See "Frequency" on page 45
See "Frequency" on page 45

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:NUMBer <EonAFANumFreq>

Defines the number of alternative frequencies.

Parameters:
<EonAFANumFreq> integer

Range: 0  to  25
*RST: 0

Manual operation: See "Num. of Frequencies" on page 44

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:FREQuency<ch> <EonAFBFreq>

Sets the alternative frequencies in EON for AF mapped frequencies method.
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Suffix: 
<ch>

.
1 to 25
Selects the alternative frequency.

Parameters:
<EonAFBFreq> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: 87.6
Default unit: MHz

Manual operation: See "Num. of Frequencies" on page 45

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:NUMBer <EonAFBNumFreq>

Parameters:
<EonAFBNumFreq> integer

Range: 0  to  4
*RST: 0

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:TFRequency <EonAFTFreq>

Sets the tuning frequency of EON in AF mapped frequencies method.

Parameters:
<EonAFTFreq> float

Range: 87.6  to  107.9
Increment: 0.1
*RST: 87.6
Default unit: MHz

Manual operation: See "Tuning Frequency" on page 45

[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:METHod <EonAFMethod>

Parameters:
<EonAFMethod> MAPF | A

*RST: A

Manual operation: See "EON AF Method" on page 43

6.7  FM RDS TMC commands

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:APPLy............................................................... 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G3A:VAR<ch>.................................................... 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk2.............................................. 80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk3a.............................................80
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk4.............................................. 81
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[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A:NUMBer..................................................... 81
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:READy?.............................................................81
[:SOURce<hw>]:BB:RADio:FM:RDS:TMC[:STATe].............................................................. 81

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:APPLy

Parameters:
<TMCApply> select

*RST: 0

Manual operation: See "Apply" on page 50

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G3A:VAR<ch> <G3AVar>

Sets the traffic message channel 3A group variants.

Suffix: 
<ch>

.
1 to 2
Selects the group type variant.

Parameters:
<G3AVar> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 3 table" on page 47

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk2 <G8ABlk2>

Parameters:
<G8ABlk2> integer

Range: 0  to  31
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 48

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk3a <GA8Blk3>

Parameters:
<GA8Blk3> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 48
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[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A<ch>:BLOCk4 <G8ABlk4>

Parameters:
<G8ABlk4> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 48

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:G8A:NUMBer <G8ANo>

Defines the number of TMC A8 groups.

Parameters:
<G8ANo> integer

Range: 1  to  6
*RST: 1

Manual operation: See "Num. of 8A Groups (Hex)" on page 48

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC:READy?

Return values: 
<TMCReady> 1 | ON | 0 | OFF

*RST: 0

Usage: Query only

Manual operation: See "Apply" on page 50

[:SOURce<hw>]:BB:RADio:FM:RDS:TMC[:STATe] <TMCState>

Enables the traffic message channel.

Parameters:
<TMCState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "TMC" on page 47

6.8  FM RDS OPF commands

● General commands.................................................................................................82
● Block 2 commands..................................................................................................82
● Block 3 commands..................................................................................................83
● Block 4 commands..................................................................................................85
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6.8.1  General commands

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF[:STATe]...............................................................82
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:APPLy................................................................82

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF[:STATe] <OpenFormatState>

Enables the open format.

Parameters:
<OpenFormatState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Open Format" on page 51

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:APPLy

Triggers transmission of open format data.

Manual operation: See "Apply" on page 52

6.8.2  Block 2 commands

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk2........................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk2......................................................83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk2.................................................... 83
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk2.................................................... 83
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[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk2 <OFG1ABlk2>
Sets block 2 of the open format group types A.

Parameters:
<OFG1ABlk2> integer

Range: 0  to  31
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk2 <OFG1ABlk2>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk2 <OFG1ABlk2>
Sets block 2 of the open format group types B.

Parameters:
<OFG1ABlk2> integer

Range: 0  to  31
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

6.8.3  Block 3 commands

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk3........................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk3......................................................84
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[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk3......................................................84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk3.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk3.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk3.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk3.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk3?.................................................... 84
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk3?.................................................... 85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk3?.................................................. 85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk3?...................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk3?.................................................. 85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk3?.................................................. 85

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk3 <OpenFormatBlk3>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk3 <OpenFormatBlk3>
Sets block 3 of the open format group types A.

Parameters:
<OpenFormatBlk3> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk3?

FM RDS OPF commands
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[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk3?
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk3?
Sets block 3 of the open format group types B.

Return values: 
<OpenFormatBlk3> integer

Range: 0  to  65535
*RST: 0

Usage: Query only

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

6.8.4  Block 4 commands

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk4........................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk4......................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk4......................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk4......................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk4......................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk4......................................................85
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk4......................................................86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk4.................................................... 86
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk4.................................................... 86

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:GA:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7A:BLOCk4 <OpenFormatBlk4>

FM RDS OPF commands
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[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13A:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G15A:BLOCk4 <OpenFormatBlk4>
Sets block 4 of the open format group types A.

Parameters:
<OpenFormatBlk4> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G1B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G3B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G4B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G5B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G6B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G7B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G8B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G9B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G10B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G11B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G12B:BLOCk4 <OpenFormatBlk4>
[:SOURce<hw>]:BB:RADio:FM:RDS:OPF:G13B:BLOCk4 <OpenFormatBlk4>
Sets block 4 of the open format group types B.

Parameters:
<OpenFormatBlk4> integer

Range: 0  to  65535
*RST: 0

Manual operation: See "Block 2 | Block 3 | Block 4" on page 52

6.9  DARC commands

[:SOURce<hw>]:BB:RADio:FM:DARC:BIC<ch>.................................................................. 86
[:SOURce<hw>]:BB:RADio:FM:DARC:DEViation................................................................ 87
[:SOURce<hw>]:BB:RADio:FM:DARC:INFormation.............................................................87
[:SOURce<hw>]:BB:RADio:FM:DARC[:STATe]....................................................................87

[:SOURce<hw>]:BB:RADio:FM:DARC:BIC<ch> <DarcBIC>

Specifies data for block identification codes 1 to 3.

DARC commands
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Suffix: 
<ch>

.
BIC 1 to 3

Parameters:
<DarcBIC> string

Manual operation: See "Data BIC 1/2/3" on page 53

[:SOURce<hw>]:BB:RADio:FM:DARC:DEViation <FreqDevDarc>

Parameters:
<FreqDevDarc> float

Range: 0  to  10
Increment: 0.01
*RST: 7.50

Manual operation: See "Freq. Dev. DARC" on page 27

[:SOURce<hw>]:BB:RADio:FM:DARC:INFormation <DarcInf>

Parameters:
<DarcInf> OFF | PRBS | DATa

*RST: OFF

Manual operation: See "Information" on page 53

[:SOURce<hw>]:BB:RADio:FM:DARC[:STATe] <Darc>

Parameters:
<Darc> 1 | ON | 0 | OFF

*RST: 1

Manual operation: See "DARC" on page 27

6.10  FM special commands

[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot:PHASe....................................................... 87
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot[:STATe].......................................................88
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:SETTings[:STATe]................................................ 88
[:SOURce<hw>]:BB:RADio:FM[:SPECial]:RDS:PHASe........................................................88

[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot:PHASe <OffsetPilot>

Sets the phase offset of the 19 kHz pilot tone.

FM special commands
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Parameters:
<OffsetPilot> float

Range: -180  to  180
Increment: 0.1
*RST: 0

Manual operation: See "Phase Offset Pilot" on page 54

[:SOURce<hw>]:BB:RADio:FM[:SPECial]:PILot[:STATe] <Pilot>

Enables/disables the 19 kHz pilot tone.

Parameters:
<Pilot> 1 | ON | 0 | OFF

*RST: 1

Manual operation: See "Pilot" on page 54

[:SOURce<hw>]:BB:RADio:FM[:SPECial]:SETTings[:STATe] <SpecialSettings>

Enables/disables special settings.

The setting allows you to switch between standard-compliant and user-defined channel
coding.

Parameters:
<SpecialSettings> 1 | ON | 0 | OFF

*RST: n.a. (no preset. default: 0)

Manual operation: See "Special Settings" on page 54

[:SOURce<hw>]:BB:RADio:FM[:SPECial]:RDS:PHASe <OffsetRDS>

Sets the phase offset of the suppressed 57 kHz RDS carrier.

Parameters:
<OffsetRDS> float

Range: -180  to  180
Increment: 0.1
*RST: 0

Manual operation: See "Phase Offset RDS" on page 55

FM special commands
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Annex
A  RDS data entry information

Some FM signal parameters require specific data entries. This chapter provides the
necessary information.
● To define names, e.g. of a PS, or to enter an RT, use the character set as in Fig-

ure A-1.
● For RDS/RBDS, program type codes and their associated names are listed in the

following tables: Table A-1, Table A-2
● For RDS and RBDS, the frequency coding for alternative frequencies is listed in

the following tables: Table A-3, Table A-4

Figure A-1: Character sets for names

Table A-1: Program type codes for RDS

No. Code Program type 8-character display 16-character display

0 00000 No type or undefined None None

1 00001 News News News

2 00010 Current affairs Affairs Current Affairs

3 00011 Information Info Information

4 00100 Sport Sport Sport

5 00101 Education Educate Education

6 00110 Drama Drama Drama

7 00111 Culture Culture Cultures
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No. Code Program type 8-character display 16-character display

8 01000 Science Science Science

9 01001 Varied Varied Varied Speech

10 01010 Pop music Pop M Pop Music

11 01011 Rock music Rock M Rock Music

12 01100 Easy listening music Easy M Easy Listening

13 01101 Light classical Light M Light Classics M

14 01110 Serious classical Classics Serious Classics

15 01111 Other music Other M Other Music

16 10000 Weather Weather Weather & Metr

17 10001 Finance Finance Finance

18 10010 Children's programs Children Children's Progs

19 10011 Social affairs Social Social Affairs

20 10100 Religion Religion Religion

21 10101 Phone in Phone In Phone In

22 10110 Travel Travel Travel & Touring

23 10111 Leisure Leisure Leisure & Hobby

24 11000 Jazz music Jazz Jazz Music

25 11001 Country music Country Country Music

26 11010 National music National M National Music

27 11011 Oldies music Oldies Oldies Music

28 11100 Folk music Folk M Folk Music

29 11101 Documentary Document Documentary

30 11110 Alarm test TEST Alarm Test

31 11111 Alarm Alarm ! Alarm - Alarm !

Table A-2: Program type codes for RBDS

No. Code Program type 8-character display 16-character display

0 0 No type or undefined None None

1 1 News News News

2 10 Information Inform Information

3 11 Sports Sports Sports

4 100 Talk Talk Talk

5 101 Rock Rock Rock

6 110 Classic rock Cls_Rock Classic_Rock
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No. Code Program type 8-character display 16-character display

7 111 Adult hits Adlt_Hit Adult_Hits

8 1000 Soft rock Soft_Rck Soft_Rock

9 1001 Top 40 Top_40 Top_40

10 1010 Country Country Country

11 1011 Oldies Oldies Oldies

12 1100 Soft Soft Soft

13 1101 Nostalgia Nostalgia Nostalgia

14 1110 Jazz Jazz Jazz

15 1111 Classical Classicl Classical

16 10000 Rhythm and blues R_&_B Rhythm_and_Blues

17 10001 Soft rhythm and blues Soft_R&B Soft_R_&_B

18 10010 Foreign language Language Foreign_Language

19 10011 Religious music Rel_Music Religious_Music

20 10100 Religious talk Rel_Talk Religious_Talk

21 10101 Personality Persnlty Personality

22 10110 Public Public Public

23 10111 College College College

24-28 11000 to
11100

Unassigned   

29 11101 Weather Weather Weather

30 11110 Emergency test Test Emergency_Test

31 11111 Emergency ALERT ! ALERT!_ALERT!

Table A-3: VHF code table

Number Binary code Carrier frequency

0 0000 0000 Not to be used

1 0000 0001 87.6 MHz

2 0000 0010 87.7 MHz

: : :

204 1100 1100 107.9 MHz

Table A-4: Special meanings code table

Number Binary code Special meaning

0 0000 0000 Not to be used

205 1100 1101 Filler code
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Number Binary code Special meaning

206 1100 1110 Not assigned

: : :

223 1101 1111 Not assigned

224 1110 0000 No AF exists

225 1110 0001 1 AF follows

: : :

249 1111 1001 25 AFs follow

250 1111 1010 An LF/MF frequency follows

251 1111 1011 Not assigned

: : :

255 1111 1111 Not assigned



Glossary: AbbreviationsR&S®SMCVB-K155

93User Manual 1179.1012.02 ─ 05

Glossary: Abbreviations
A

AF: Alternative Frequencies list

AM: Amplitude Modulation

B
BIC: Block Identification Code

C
CI: Country Identifier

CT: Clock Time and date

D
DARC: Data Radio Channel
See EN 300 751.

DI: Decoder Identification

E
EG: Extended Generic indicator

EON: Enhanced Other Networks information

F
FM: Frequency Modulation

I
ILS: International Linkage Set

L
LA: Linkage Actuator

LI: Linkage Identifier

LSN: Linkage Set Number

LW: Long Wave

M
MS: Music Speech switch
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MW: Medium Wave

O
ODA: Open Data Applications

P
PI: Program Identification

PIN: Program Item Number

PRBS: Pseudo-Random Bit Sequence

PS: Program Service name

PTY: Program Type

PTYI: Dynamic Program Type Indicator

PTYN: Program Type Name

R
RBDS: Radio Broadcast Data System

RDS: Radio Data System

RT: Radio Text

S
S/PDIF: Sony/Philips Digital Interface

SNR: Signal to Noise Ratio

T
TA: Traffic Announcement flag

TMC: Traffic Message Channel

TP: Traffic Program flag
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Glossary: Specifications
E

EN 300 751: Radio broadcasting systems; DAta Radio Channel (DARC); System for
wireless infotainment forwarding and teledistribution
https://www.etsi.org/deliver/etsi_en/300700_300799/300751/

EN 62106: Specification of the radio data system (RDS) for VHF/FM sound broadcast-
ing in the frequency range from 87,5 to 108,0 MHz

EN ISO 14819-1: Intelligent transport systems — Traffic and travel information mes-
sages via traffic message coding — Part 1: Coding protocol for Radio Data System —
Traffic Message Channel (RDS-TMC) using ALERT-C

 

https://www.etsi.org/deliver/etsi_en/300700_300799/300751/


List of commandsR&S®SMCVB-K155

96User Manual 1179.1012.02 ─ 05

List of commands
[:SOURce<hw>]:BB:RADio:AM:APLayer:ATT.................................................................................................59
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:CATalog............................................................................ 60
[:SOURce<hw>]:BB:RADio:AM:APLayer:LIBRary:SELect..............................................................................60
[:SOURce<hw>]:BB:RADio:AM:AUDGen:FRQ............................................................................................... 60
[:SOURce<hw>]:BB:RADio:AM:AUDGen:LEV................................................................................................ 60
[:SOURce<hw>]:BB:RADio:AM:AUDio:AF...................................................................................................... 61
[:SOURce<hw>]:BB:RADio:AM:DEPTh...........................................................................................................61
[:SOURce<hw>]:BB:RADio:AM:INPut............................................................................................................. 61
[:SOURce<hw>]:BB:RADio:AM:MODulation:DEPTh?.....................................................................................61
[:SOURce<hw>]:BB:RADio:AM:PRESet..........................................................................................................58
[:SOURce<hw>]:BB:RADio:AM:SETTing:CATalog.......................................................................................... 58
[:SOURce<hw>]:BB:RADio:AM:SETTing:DELete........................................................................................... 59
[:SOURce<hw>]:BB:RADio:AM:SETTing:LOAD..............................................................................................59
[:SOURce<hw>]:BB:RADio:AM:SETTing:STORe............................................................................................59
[:SOURce<hw>]:BB:RADio:AM:SOURce........................................................................................................ 62
[:SOURce<hw>]:BB:RADio:AM:STATe............................................................................................................ 58
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT1............................................................................................... 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:ATT2............................................................................................... 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:CATalog............................................................................ 64
[:SOURce<hw>]:BB:RADio:FM:APLayer:LIBRary:SELect.............................................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ1..............................................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:FRQ2..............................................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV1.............................................................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDGen:LEV2.............................................................................................. 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF1.....................................................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDio:AF2.....................................................................................................65
[:SOURce<hw>]:BB:RADio:FM:AUDio:DEViation?......................................................................................... 65
[:SOURce<hw>]:BB:RADio:FM:AUDio:MODE................................................................................................ 66
[:SOURce<hw>]:BB:RADio:FM:AUDio:NDEViation.........................................................................................66
[:SOURce<hw>]:BB:RADio:FM:AUDio:PREemphasis.................................................................................... 66
[:SOURce<hw>]:BB:RADio:FM:AUDio:SOURce?...........................................................................................66
[:SOURce<hw>]:BB:RADio:FM:DARC:BIC<ch>............................................................................................. 86
[:SOURce<hw>]:BB:RADio:FM:DARC:DEViation........................................................................................... 87
[:SOURce<hw>]:BB:RADio:FM:DARC:INFormation........................................................................................87
[:SOURce<hw>]:BB:RADio:FM:DARC[:STATe]............................................................................................... 87
[:SOURce<hw>]:BB:RADio:FM:INPut..............................................................................................................67
[:SOURce<hw>]:BB:RADio:FM:MODE............................................................................................................67
[:SOURce<hw>]:BB:RADio:FM:PILot:DEViation............................................................................................. 68
[:SOURce<hw>]:BB:RADio:FM:PRESet..........................................................................................................62
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:FREQuency<ch>?....................................................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:A:NUMBer....................................................................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:DESC<ch>........................................................................ 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:FREQuency<ch>...............................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:NUMBer.............................................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST1:TFRequency......................................................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:DESC<ch>........................................................................ 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:FREQuency<ch>...............................................................74
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[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:NUMBer.............................................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST2:TFRequency......................................................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:DESC<ch>........................................................................ 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:FREQuency<ch>...............................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:NUMBer.............................................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST3:TFRequency......................................................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:DESC<ch>........................................................................ 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:FREQuency<ch>...............................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:NUMBer.............................................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST4:TFRequency......................................................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:DESC<ch>........................................................................ 73
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:FREQuency<ch>?.............................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:NUMBer.............................................................................74
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:B:LIST5:TFRequency......................................................................75
[:SOURce<hw>]:BB:RADio:FM:RDS:AF:METHod.......................................................................................... 73
[:SOURce<hw>]:BB:RADio:FM:RDS:CT......................................................................................................... 71
[:SOURce<hw>]:BB:RADio:FM:RDS:CTOFfset.............................................................................................. 71
[:SOURce<hw>]:BB:RADio:FM:RDS:DEViation..............................................................................................68
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:ARTificial.......................................................................................... 71
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:COMPressed....................................................................................71
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:DYNamic.......................................................................................... 72
[:SOURce<hw>]:BB:RADio:FM:RDS:DI:STEReo............................................................................................72
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:FREQuency<ch>.................................................................78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:A:NUMBer.............................................................................. 78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:FREQuency<ch>.................................................................78
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:NUMBer.............................................................................. 79
[:SOURce<hw>]:BB:RADio:FM:RDS:EON:AF:B:TFRequency........................................................................79
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